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保証

当社では、本製品において、出荷の日から 1 年間、材料およびその仕上がりについて欠陥がないことを保証します。
この保証期間中に製品に欠陥があることが判明した場合、当社では、当社の裁量に基づき、部品および作業の費
用を請求せずに当該欠陥製品を修理するか、あるいは当該欠陥製品の交換品を提供します。保証時に当社が使用
する部品、モジュール、および交換する製品は、新しいパフォーマンスに適応するために、新品の場合、または再生
品の場合もあります。交換したすべての部品、モジュール、および製品は当社で保有されます。

本保証に基づきサービスをお受けいただくため、お客様には、本保証期間の満了前に当該欠陥を当社に通知して
いただき、サービス実施のための適切な措置を講じていただきます。お客様には、当該欠陥製品を梱包していただ
き、送料前払いにて当社指定のサービス・センターに送付していただきます。本製品がお客様に返送される場合に
おいて、返送先が当該サービス・センターの設置されている国内の場所であるときは、当社は、返送費用を負担し
ます。しかし、他の場所に返送される製品については、すべての送料、関税、税金その他の費用をお客様に負担し
ていただきます。

本保証は、不適切な使用または不適切もしくは不十分な保守および取り扱いにより生じたいかなる欠陥、故障または
損傷にも適用されません。当社は、以下の事項については、本保証に基づきサービスを提供する義務を負いません。
a）当社担当者以外の者による本製品のインストール、修理またはサービスの試行から生じた損傷に対する修理。b）不
適切な使用または互換性のない機器への接続から生じた損傷に対する修理。c）当社製ではないサプライ用品の使用
により生じた損傷または機能不全に対する修理。d）本製品が改造または他の製品と統合された場合において、改造
または統合の影響により当該本製品のサービスの時間または難度が増加したときの当該本製品に対するサービス。

この保証は、明示的または黙示的な他のあらゆる保証の代わりに、製品に関して当社がお客様に対して提供するも
のです。当社およびベンダは、商品性または特定目的に対する適合性についての一切の黙示保証を否認します。
欠陥製品を修理または交換する当社の責任は、本保証の不履行についてお客様に提供される唯一の排他的な法
的救済となります。間接損害、特別損害、付随的損害または派生損害については、当社およびそのベンダは、損害
の実現性を事前に通知されていたか否に拘わらず、一切の責任を負いません。
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安全にご使用いただくために

安全にご使用いただくために

人体への損傷を避け、本製品や本製品に接続されている製品への損傷を防止するために、次の安全性に
関する注意をよくお読みください。

安全にご使用いただくために、本製品の指示に従ってください。

資格のあるサービス担当者以外は、保守点検手順を実行しないでください。

本製品をご使用の際に、規模の大きなシステムの他の製品にアクセスしなければならない場合があります。
システムの操作に関する警告や注意事項については、他製品のマニュアルにある安全に関するセクション
をお読みください。

火災や人体への損傷を避けるには

適切な電源コードを使用してください。 本製品用に指定され、使用される国で認定された電源コードの
みを使用してください。

本製品を接地してください。 本製品は、電源コードのグランド線を使用して接地します。 感電を避けるた
め、グランド線をアースに接続する必要があります。 本製品の入出力端子に接続する前に、製品が正しく接
地されていることを確認してください。

すべての端子の定格に従ってください。 火災や感電の危険を避けるために、本製品のすべての定格と
マーキングに従ってください。 本製品に電源を接続する前に、定格の詳細について、製品マニュアルを参
照してください。

本製品の定格は測定カテゴリＩになります。一次回路、設置カテゴリＩＩ，ＩＩＩ，およびＩＶの回路には接続しな
いでください。

電源を切断してください。 電源コードの取り外しによって主電源が切り離されます。電源コードをさえぎら
ないでください。このコードは常にアクセス可能であることが必要です。

カバーを外した状態で動作させないでください。 カバーやパネルを外した状態で本製品を動作させな
いでください。

故障の疑いがあるときは動作させないでください。 本製品に故障の疑いがある場合、資格のあるサー
ビス担当者に検査してもらってください。

露出した回路への接触は避けてください。 電源がオンのときに、露出した接続部分やコンポーネントに
触れないでください。

バッテリの交換を正しく行ってください。 指定されたタイプおよび定格のバッテリと交換してください。

適切なヒューズを使用してください。 本製品用に指定されたタイプおよび定格のヒューズのみを使用し
てください。

湿気の多いところでは動作させないでください。

爆発性のあるガスがある場所では使用しないでください。

製品の表面を清潔で乾燥した状態に保ってください。

適切に通気してください。 適切な通気が得られるような製品の設置方法の詳細については、マニュアル
の設置方法を参照してください。
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安全にご使用いただくために

本マニュアル内の用語

本マニュアルでは、次の用語を使用します。

警告： 人体や生命に危害をおよぼすおそれのある状態や行為を示します。

注意： 本製品やその他の接続機器に損害を与える状態や行為を示します。

本製品に関する記号と用語

本製品では、次の用語を使用します。

DANGER: ただちに人体や生命に危険をおよぼす可能性があることを示します。

WARNING: 人体や生命に危険をおよぼす可能性があることを示します。

CAUTION: 本製品を含む周辺機器に損傷を与える可能性があることを示します。

本製品では、次の記号を使用します。

iv RSA6100A シリーズ・クイック・スタート・ユーザ・マニュアル



適合性に関する情報

適合性に関する情報

このセクションでは、本機器が適合している EMC 基準、安全基準、および環境基準について説明します。

EMC

EC 適合宣言 - EMC

指令 2004/108/EC 電磁環境両立性に適合します。『Official Journal of the European Communities』に記載
の以下の基準に準拠します。

EN 61326-1:2006、EN 61326-2-1:2006: 測定、制御、および実験用途の電子機器を対象とする EMC 基
準。 1 2 3 4

CISPR 11:2003：グループ 1、クラス A、放射および伝導エミッション

IEC 61000-4-2:2001：静電気放電イミュニティ

IEC 61000-4-3:2002：RF 電磁界イミュニティ 5

IEC 61000-4-4:2004：電気的ファスト・トランジェント／バースト・イミュニティ

IEC 61000-4-5:2001：電源サージ・イミュニティ

IEC 61000-4-6:2003：伝導 RF イミュニティ 6

IEC 61000-4-11:2004：電圧低下と停電イミュニティ 7

EN 61000-3-2:2006: AC 電源高調波エミッション

EN 61000-3-3:1995: 電圧の変化、変動、およびフリッカ

欧州域内連絡先:
Tektronix UK, Ltd.
Western Peninsula
Western Road
Bracknell, RG12 1RF
United Kingdom

1 本製品は住居区域以外での使用を目的としたものです。住居区域で使用すると、電磁干渉の原因となることがあります。

2 本製品をテスト対象に接続した状態では、この規格が要求するレベルを超えるエミッションが発生する可能性があります。

3 ここに挙げた各種 EMC 規格に確実に準拠するには、高品質なシールドを持つインタフェース・ケーブルが必要です。

4 IEC 61000-4-11 の 0%/250 サイクルの電圧遮断過渡イミュニティ・テストでは、EUT の再起動から復帰までに 10 秒以上を
要する場合があります。

5 IEC 61000-4-3 テストに関する性能劣化情報： 外乱レベルによっては、残留スプリアス信号は一般的に最大 -55 dBm ま
で上がることがあります。

6 IEC 61000-4-6 テストに関する性能劣化情報： 外乱レベルによっては、残留スプリアス信号は一般的に（基準 - 55 dB）ま
たは（-75 dBm）のうち、より好ましくないレベルまで上がることがあります。

7 70%/25 サイクルの電圧低下および 0%/250 サイクル瞬断の各テスト・レベルにおいて、性能基準 C を適用します（IEC
61000-4-11）。

RSA6100A シリーズ・クイック・スタート・ユーザ・マニュアル v



適合性に関する情報

オーストラリア／ニュージーランド適合宣言 - EMC

ACMA に従い、次の規格に準拠することで Radiocommunications Act の EMC 条項に適合しています。

CISPR 11:2003：グループ 1、クラス A、放射および伝導エミッション（EN61326-1:2006 および EN61326-
2-1:2006 に準拠）

安全性

EC 適合宣言 - 低電圧指令

『Official Journal of the European Communities』に記載の以下の基準に準拠します。

低電圧指令 2006/95/EC

EN 61010-1：2001：測定、制御および実験用途の電子装置に対する安全基準

米国の国家認定試験機関のリスト

UL 61010-1:2004 年第 2 版。電子計測機器および試験用機器の標準規格

カナダ認証

CAN/CSA-C22.2 No.61010-1:2004：測定、制御、および研究用途の電子装置に対する安全基準、第 1
部

その他の基準に対する適合性

IEC 61010-1：2001：測定、制御、および実験用途の電子装置に対する安全基準

機器の種類

測定機器

安全クラス

クラス 1：アース付き製品

汚染度

製品内部およびその周辺で発生する可能性がある汚染の尺度です。通常、製品の内部環境は外部環境と
同じとみなされます。製品は、その製品に指定されている環境でのみ使用してください。

汚染度 1：汚染なし、または乾燥した非導電性の汚染のみが発生します。このカテゴリの製品は、通常、
被包性、密封性のあるものか、クリーン・ルームでの使用を想定したものです。

汚染度 2：通常、乾燥した非導電性の汚染のみが発生します。ただし、結露によって一時的な導電性が
発生することもまれにあります。これは、標準的なオフィスや家庭内の環境に相当します。一時的な結露
は製品非動作時のみ発生します。
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適合性に関する情報

汚染度 3：導電性のある汚染、または通常は乾燥して導電性を持たないが結露時に導電性を帯びる汚
染。これは、温度、湿度のいずれも管理されていない屋内環境に相当します。日光や雨、風に対する直
接の曝露からは保護されている領域です。

汚染度 4：導電性のある塵、雨、または雪により持続的な導電性が生じる汚染。これは一般的な屋外環
境に相当します。

汚染度

汚染度 2（IEC 61010-1 の定義による）。注：屋内使用のみについての評価です。

環境条件について
このセクションでは、製品の環境に対する影響について説明します。

使用済み製品の処理方法

機器またはコンポーネントをリサイクルする際には、次のガイドラインを順守してください。

機器のリサイクル: この機器を生産する際には、天然資源が使用されています。本製品には環境または
人体に有害となる可能性のある物質が含まれているため、廃棄の際には適切に処理する必要があります。
有害物質の放出を防ぎ、天然資源の使用を減らすため、本製品の部材の再利用とリサイクルの徹底にご協
力ください。

この記号は、本製品が WEEE（廃棄電気・電子機器）およびバッテリに関する Directive
2002/96/EC および 2006/66/EC に基づき、EU の諸要件に準拠していることを示しています。
リサイクル方法については、Tektronix Web サイト（www.tektronix.com）の「Service & Support」
のセクションを参照してください。

水銀に関するお知らせ: この製品に使用されている LCD バックライト・ランプには、水銀が含まれてい
ます。廃棄にあたっては、環境への配慮が必要です。廃棄およびリサイクルに関しては、お住まいの地域
の所轄官庁にお尋ねください。

有害物質に関する規制

本製品は Monitoring and Control（監視および制御）装置に分類され、2002/95/EC RoHS Directive（電気・
電子機器含有特定危険物質使用制限指令）の範囲外です。
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このマニュアルでは、RSA6100A シリーズ・リアルタイム・スペクトラム・アナライザの設置と基本的な操作につ
いて説明します。詳細については、機器のオンライン・ヘルプを参照してください。

主な機能
RSA6100A シリーズは、高性能のリアルタイム・スペクトラム・アナライザ・ファミリです。主な機能は次の通り
です。

デジタル・フォスファ・スペクトラム解析により、障害発生の認識と特定にかかる時間を短縮できる

DPX 密度トリガ機能により、他の信号アナライザでは取り込めない不安定性、トランゼント、および隠れ
ている信号を簡単に取り込める

スペクトラム解析用の従来のコントロールと機能を踏襲（高速チューニング測定、マーカ測定、位相ノイ
ズ測定、スプリアス測定など）

周波数領域の変化をトリガとし（当社独自の周波数マスク・トリガを使用）、トランゼント RF 信号をイベント
ベースで取り込める

時間領域でラント・トリガ、ホールドオフ・トリガが使用可能。 また、オプション 200 型により、機器のすべ
てのトリガ形式で時間クオリフィケーションが可能

時間と共に変化する RF 信号が、マルチドメイン表示で一目で理解できる

オプション 21 型により、従来のベクトル信号解析が可能（20 種超の代表的な変調フォーマットに対応）

最大 110 MHz のスパンで信号をシームレスに取り込める

マニュアル
当社の RSA6100A シリーズ・スペクトラム・アナライザには、次のマニュアルが用意されています。最新のマ
ニュアルについては、Tektronix ホームページを参照してください。

参照する項目 使用するマニュアル

設置と操作（概要） 『RSA6100A シリーズ・リアルタイム・スペクトラム・アナライザ・クイック・スター
ト・ユーザ・マニュアル』。 このマニュアルには、機器の使用準備と基本操作、
ユーザ・インタフェース、およびコントロールの概要が記載されています。

操作とユーザ ・ インタ
フェースに関する詳細な
ヘルプ

『RSA6100A シリーズ・リアルタイム・スペクトラム・アナライザ・オンライン・ヘル
プ』。このオンライン・ヘルプでは、機器の操作方法について詳しく説明して
います。
このオンライン・ヘルプでは、機器の操作方法について詳しく説明しています。

使用例 『RSA6100A シリーズ・リアルタイム・スペクトラム・アナライザ使用例マニュア
ル』。このマニュアルでは、アナライザの実用例を紹介します。

プログラミング・コマンド 『RSA6100A シリーズ・リアルタイム・スペクトラム・アナライザ・プログラマ・マニュ
アル』。 RSA6100A シリーズのプログラミング・コマンドは、ドキュメント CD に収
録の PDF ファイルに別掲。
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参照する項目 使用するマニュアル

仕様と性能検査 『RSA6100A シリーズ・リアルタイム・スペクトラム・アナライザ・テクニカル・リファ
レンス・マニュアル』。
このマニュアルでは、機器の仕様および性能チェック（保証特性との照合）手
順を説明します。このマニュアルは、ドキュメント CD に収録されている PDF
ファイルです。

ユーザ・サービス 『RSA6100A シリーズ・リアルタイム・スペクトラム・アナライザ・サービス・マニュ
アル』。交換部品リスト、注意および保守情報、モジュール・レベルの修理情
報が記載されたマニュアル（オプション）。このマニュアルは、ドキュメント CD
に収録されている PDF ファイルです。

ソフトウェアのアップグレード
ソフトウェアのアップグレードを入手できます。スペクトラム・アナライザ・モデルとシリアル番号に合った正し
いオプション・キーを入力した場合にのみ、ソフトウェアのアップグレードが適用されます。

新しいアップグレードの有無を確認するには、次の手順に従います。

1. Web ブラウザを使用して、www.tektronix.com/software にアクセスします。

2. 製品名（RSA6100A）を入力し、入手可能なソフトウェアのアップグレードを検索します。

このマニュアルの表記規則
このマニュアルで使用するアイコンの意味は、次のとおりです。

操作手順の
番号

電 源 オ ン
（フロント･パ
ネル）

電源コード
接続

ネットワーク
接続

PS2 接続 SVGA 接続 USB 接続

RSA6100A シリーズ・クイック・スタート・ユーザ・マニュアル ix



まえがき

x RSA6100A シリーズ・クイック・スタート・ユーザ・マニュアル



設置

設置

設置の前に
機器を開梱し、スタンダード・アクセサリとして記載されている品目がすべて揃っていることを確認します。ま
た、オプショナル・アクセサリおよび機器オプションもこのセクションに記載されています。最新の情報につい
ては、Tektronix ホームページ（www.tektronix.com）を参照してください。

スタンダード・アクセサリ
機器には、 クイック･スタート･ユーザ･マニュアル（対応言語は以下に記載）、プログラマ･マニュアル（CD）、 テク
ニカル・リファレンス・マニュアル（CD）、サービス・マニュアル（CD）、電源コード、BNC-N アダプタ（RSA6106A
型および RSA6114A 型のみ、当社部品番号 103-0045-XX）、Jack-to-Jack SMA アダプタ（RSA6120A 型の
み、当社部品番号 131-8508-XX）、50 Ω SMA終端装置（RSA6120A 型のみ、当社部品番号 015-1022-XX）、
USB キーボード、USB マウスおよびアクセサリ・ポーチなどのアクセサリが付属しています。

マニュアル

『RSA6100A シリーズ・リアルタイム・スペクトラム・アナライザ・クイック・スタート・ユーザ・マニュアル』は、
次の言語版があります。

英語、当社部品番号 071-1909-XX

簡体字中国語、当社部品番号 071-1910-XX

日本語、当社部品番号 071-1911-XX

ロシア語、当社部品番号 071-1912-XX

『RSA6100A シリーズ・リアルタイム・スペクトラム・アナライザ・ドキュメント CD』、当社部品番号 063-
3930-XX。ドキュメント CD には、次のマニュアルの PDF 版が収録されています。

『RSA6100A シリーズ・リアルタイム・スペクトラム・アナライザ・クイック・スタート・ユーザ・マニュアル』
（英語、日本語、ロシア語、簡体字中国語）

『RSA6100A シリーズ・リアルタイム・スペクトラム・アナライザ使用例マニュアル』、当社部品番号
071-2590-XX

『RSA6100A シリーズ・リアルタイム・スペクトラム・アナライザ･オンライン･ヘルプ』（印刷可）、当社部
品番号 077-0169-XX

『RSA6100A シリーズ・リアルタイム・スペクトラム・アナライザ・プログラマ・マニュアル』、当社部品番
号 077-0249-XX

『RSA6100A シリーズ・リアルタイム・スペクトラム・アナライザ・サービス・マニュアル』、当社部品番号
077-0250-XX

『RSA6100A シリーズ・リアルタイム・スペクトラム・アナライザ・テクニカル・リファレンス・マニュアル』、
当社部品番号 077-0251-XX

『RSA6100A シリーズ・リアルタイム・スペクトラム・アナライザ・デクラシフィケーション／セキュリティ・イ
ンストラクション』、当社部品番号 077-0170-XX
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電源コード

RSA6100A シリーズ・リアルタイム・スペクトラム・アナライザには、各地域専用の電源コードが 1 本同梱され
ています。北米用の電源コードは安全性確認済みで CSA 認可済みのものです。北米以外の地域用のコー
ドは、当該国の機関（1 つ以上）により承認されているものです。

各国の電源プラグ

Opt. A0 – 北米仕様電源

Opt. A1 – ユニバーサル欧州仕様電源

Opt. A2 – 英国仕様電源

Opt. A3 – オーストラリア仕様電源

Opt. A4 – 240 V 北米仕様電源

Opt. A5 – スイス仕様電源

Opt. A6 – 日本仕様電源

Opt. A10 – 中国仕様電源

Opt. A11 – インド仕様電源

Opt. A99 – 電源コードなし

オプショナル・アクセサリ
RSA61RHD 型 - オプション 06 型で提供される増設リムーバブル・ハード・ディスク・ドライブ

065-0765-XX 型 - オプション 08 型で提供される増設リムーバブル・ソリッドステート・ハード・ドライブ
（Microsoft Windows XP Embedded および機器ソフトウェアがプレインストール）
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オプション
スペクトラム・アナライザには、次のオプションを追加できます。

オプション 01 型 - 10 MHz ～ 3 GHz のプリアンプの追加

オプション 02 型 - 周波数マスク・トリガおよび RAM 拡張の追加

オプション 05 型 - デジタル IQ 出力および 500 MHz のアナログ IF 出力の追加

オプション 06 型 - リムーバブル・ハード・ディスク・ドライブの追加（オプション 07 型またはオプション 08
型との同時指定は不可）

オプション 07 型 - DVD±RW ドライブの追加、無料オプション（オプション 06 型またはオプション 08 型
との同時指定は不可）

オプション 08 型 - リムーバブル・ソリッドステート・ハード・ドライブの追加（オプション 06 型または 07 型
との同時指定は不可）

オプション 11 型 - 位相ノイズおよびジッタ測定の追加

オプション 20 型 - 拡張測定解析機能（パルス測定を含む）の追加

オプション 21 型 - 汎用デジタル変調解析の追加

オプション 110 型 - 110 MHz のリアルタイム取り込み帯域幅の追加

オプション 200 型 - 拡張 DPX およびトリガ

オプション 1R 型 - ラックマウント・キットの追加

動作条件

電源要件

電源電圧と周波数 消費電力

100 V ～ 240 VRMS、50/60 Hz

115 VRMS、400 Hz

450 W （最大、全機種共通）

環境要件

特性 説明

動作時温度 +5 ℃ ～ +50 ℃（+5 ℃ ～ +40 ℃、DVD ドライブまたはオプションの
リムーバブル・ハード・ディスク・ドライブにアクセスする場合）

温度（非動作時） -20 ℃ ～ +60 ℃

湿度 90%（30 ℃、結露なし）最大 80%（DVD ドライブへのアクセス時）最高
湿球温度 29 ℃

使用可能高度：

動作時

非動作時

3,000 m（9,843 フィート）以下

12,190 m （40,000 フィート）

冷却用スペース

底部

側面と後部

20 mm （0.79 インチ）

50 mm （1.97 インチ）
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注意： 正しく冷却するために、機器を横にして操作しないでください。機器がケース底面の脚で支えられて
いる状態でのみ、機器を操作できます。通気口周辺には、少なくとも 2 インチ（5 cm）のスペースを確保して
ください。

警告： 人的傷害を避けるために、スペクトラム・アナライザを持ち上げたり、移動したりする際は十分に注意
してください。機器は比較的重量があるので、移動の際は細心の注意が必要です。

機器への接続

ネットワークへの接続

機器の電源を入れる前に、キーボード、マウス、プリンタ、その他のアクセサリを接続します（USB 対応アク
セサリは、電源投入の前後どちらでも接続できます）。

機器をネットワークに接続すると、プリ
ンタ出力、ファイル共有、インターネッ
ト・アクセスなどの通信機能を利用でき
ます。ネットワークに接続する機器の設
定については、ネットワーク管理者に問
い合わせ、標準の Windows ユーティリ
ティを使用してください。

ヒント

機器をネットワークに接続する場合、インターネット・ファイアウォールの使用、承認済み OS 更新の定期
的なインストール、最新のアンチウィルス・ソフトウェアの使用を通じて、機器の保護に努めてください。
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機器の電源をオンにする

機器の電源をオフにする

電源コードの取り外し
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外部モニタの追加
デュアル・モニタ構成に外部モニタを追加するには、次の手順に従ってください。スペクトラム・アナライザと
外部モニタの両方で、カラーを True Color に設定する必要があります。

1. スペクトラム・アナライザと外部モニ
タの電源をオフにします。

2. 外部モニタをスペクトラム・アナライ
ザに接続します。

3. スペクトラム・アナライザと外部モニ
タの電源をオンにします。
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4. Windows の Control Panel を開きま
す。

5. Intel(R) Extreme Graphics 2 M をダ
ブルクリックして、プロパティ・ペー
ジを開きます。

6. Intel （R）Dual Display Clone をク
リックし、スペクトラム･アナライザ
（Notebook に相当）の画面を外部
モニタ（Monitor）にも出力するように
します。
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7. 必要に応じて設定を調整し、OK を
クリックすると、設定が適用され、プ
ロパティ・ページが閉じます。
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Windows の表示設定の調整

機器の表示設定を変更するには、デフォルトの Windows 表示プロパティではなく、Intel のグラフィック・ドラ
イバを使用します。Intel グラフィック・ドライバを使用すると、Windows の表示プロパティ・ダイアログ・ボックス
ではアクセスできない項目まで調節することができます。

1. Windows の Control Panel を開きま
す。

2. Intel(R) Extreme Graphics 2 M をダ
ブルクリックして、プロパティ・ペー
ジを開きます。

3. 必要に応じて、設定を調整します。

注： 外部モニタが機器に接続されてい
ない場合は、プロパティ・ページの項目
をすべて使用できるとは限りません。

4. OKをクリックして設定を適用し、プ
ロパティ・ページを閉じます。

注： 推奨はできませんが、スペクトラム・アナライザの電源をオンにした後で外部モニタを接続することもで
きます。ただし、接続後、Intel Extreme Graphics 2M のコントロール・パネルで Extended Desktop を有効に
しなければなりません。
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機器の検査
機器には、診断アプリケーションが用意されています（Tools > Diagnostics）。機器の使用中に異常が発生し
た場合は、次の手順に従って、障害の詳細情報を収集してください。この手順は、受入検査時の機器の機
能チェックにも使用できます。確度仕様のチェック方法については、ドキュメント CD に収録の PDF ファイル
『RSA6100A シリーズ・リアルタイム・スペクトラム・アナライザ・テクニカル・リファレンス・マニュアル』（当社部
品番号 077-0251-XX）を参照してください。

1. Tools > Diagnostics を選択し
ます。

2. Diagnostics タブで、All Mod-
ules, All Tests を選択します。

3. Single Test をクリックします。

4. RUN をクリックします。

機器の診断テストは、一度に 1
つずつ実行されます。テストが
完了すると、各チェック・ボック
スの右にチェック・マークまた
は X マークが表示されます。
チェック・マークはテストにパ
スしたことを、X マークはテス
トに失敗したことを示します。

5. 診断テストの中には、マニュア
ル操作を必要とするものもあ
ります。そのようなテストでは、
画面の指示に従ってテストを
進めてください。

注： Diagnostics Failure Information タブでは、基本的な診断エラー情報を参照できます。障害の履歴と、
アプリケーションによって報告されるエラー情報（診断の結果以外の情報）については、Windows の Event
Viewer（Windows の Control Panel の Administrative tools のサブセット）で参照してください。
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ユーザ保守

機器のクリーニング

シャーシの外部表面のクリーニングには、乾いた柔らかい布か柔らかい毛ブラシを使用してください。汚れ
が落ちない場合は、75% のイソプロピル・アルコール溶液をしみ込ませた布または綿棒を使用してください。
コントロールやコネクタの周りの狭い部分のクリーニングには、綿棒を使用してください。機器を損傷する恐
れがあるため、どの部分にも研磨剤を使用しないでください。

注意： 外部のクリーニング時に機器の内部が湿らないように、溶液の量は布または綿棒が湿る程度に抑え
てください。フロント・パネルの On/Standby スイッチを水拭きしないでください。機器を水拭きする場合は、
スイッチを覆ってください。クリーニング時には、純水または蒸留水だけを使用してください。洗浄剤として
75% のイソプロピル・アルコール溶液を使用し、純水または蒸留水で洗い流してください。化学薬品の洗浄
剤を使用しないでください。シャーシを損傷する恐れがあります。ベンゼン、トルエン、キシレン、アセトンま
たはこれに類似する溶剤を含有する化学薬品を使用しないでください。

注意： フラットパネル・ディスプレイが損傷する恐れがあるため、不適切な洗浄剤やクリーニング方法は使
用しないでください。ディスプレイの表面のクリーニングに、研磨剤または市販のガラス用洗剤を使用しない
でください。液体をディスプレイの表面に直接吹き付けないでください。ディスプレイを磨くときは、力を入れ
すぎないでください。

ディスプレイの表面をクリーニングする場合は、ディスプレイをクリーニング用ティッシュで優しく拭いてくださ
い。ディスプレイの汚れがひどい場合は、蒸留水または 75% のイソプロピル・アルコール溶液でティッシュを
湿らせ、ディスプレイの表面を優しく拭きます。力を入れすぎないように注意してください。ディスプレイの表
面を傷つける恐れがあります。

機器のソフトウェアのアップグレード

ソフトウェアのアップグレードは当社から入手できます。Tektronix ホームページからダウンロードするか、当
社営業所に注文してください。ソフトウェアのオプションまたは機能を追加するには、当社が発行するオプ
ション・キーが必要です。当社からソフトウェアを入手したら、これを機器にインストールします。メッセージが
表示されたら、オプション・キーを入力し、画面の指示に従ってアップグレードを完了してください。

機器の返送

機器を当社に返送される場合：

ハード・ディスク上のソフトウェアをバックアップしてください。機器が戻ってきたら、ソフトウェアを再イン
ストールする必要があります。

機器を輸送用に再梱包する場合は、元の梱包資材を使用してください。元の梱包資材が手元にない
か、使用に適していない場合は、当社営業所まで新しい梱包資材をご依頼ください。

輸送用カートンを業務用ステープルまたは丈夫なテープで止めます。
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操作

機器の概要
コントロールとディスプレイの構成を次の図と表で示します。

フロント・パネル・コントロール

ほとんどのフロント・パネル・コントロールは、コントロール・パネルを開くためのショートカットです。
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番号 アイテム 説明
同等のメニュー
操作

1 メディア DVD±RW ドライブ、リムーバブル・ハード・ディスク・
ドライブ、またはリムーバブル・ソリッドステート・ハー
ド・ドライブ

2 Displays Displays ダイアログ・ボックスを開いて、測定表示を
選択します。

Setup > Displays

3 Settings 選択した表示の Settings コントロール・パネルを開
きます。

Setup > Settings

4 Trigger Trigger コントロール・パネルを開きます。 Setup > Trigger

5 Acquire Acquire コントロール・パネルを開きます。 Setup > Acquire

6 Analysis Analysis コントロール・パネルを開きます。 Setup > Analysis

7 Freq 測定周波数を調整します。 Setup > Analysis
> Frequency タ
ブ 2

8 Span （ Spec-
trum）

Spectrum 表示に示されるスパン（周波数の範囲）を
調整します。 1

Setup > Settings
> Freq & Span 1

2

9 Amplitude 基準レベルを調整します。 Setup > Ampli-
tude 2

10 BW（Spectrum） 分解能帯域幅（RBW）を調整します。 1 Setup > Settings
> BW タブ 1 2

1 選択した表示が Spectrum、DPX Spectrum、または Spectrogram の場合にのみ適用されます。
2 1 秒間押したままにし、関連するコントロール・パネルを表示します。
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番号 アイテム 説明
同等のメニュー
操作

11 Tab ダイアログ・ボックスまたはコントロール・パネルで、
カーソルを次のエントリに移動します。外部キーボー
ドで、Tab キーを押す操作と同じです。

12 Run（Stop） アクイジションを開始または停止します。 Run > Run

13 Markers, Peak アクティブなマーカを、選択した表示の最大ピーク
のトレースに移動します。マーカがオフになると、MR
（マーカの基準）マーカが最大ピークに表示されま
す。

14 Markers, Select 次のマーカを選択します。

15 Markers, De-
fine

Markers コントロール・パネルを開きます。

16 Esc 変更を保存せずにダイアログ・ボックスを終了しま
す。

17 コントロール・ノ
ブ

数値コントロールおよびリスト・コントロールの値を
変更します。ノブを押す（ノブをクリックする）ことは、
キーボードで Enter キーを押す操作と同じです。

18 矢印キー マーカを移動します。上矢印キーを押すと、選択し
たマーカを 10 トレース・ポイント右に移動します。下
矢印キーを押すと、選択したマーカを 10 トレース・
ポイント左に移動します。左右の矢印キーを押すと、
選択したマーカを次のピークに移動します。（ノブを
回すと、マーカを 1 トレース・ポイント右または左に
移動します。
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番号 アイテム 説明
同等のメニュー
操作

19 キーパッド コントロールの値を入力します。

20 Enter コントロールのデータ・エントリを完了します。キー
ボードで、Enter キーを押す操作と同じです。

番号 アイテム 説明
同等のメニュー
操作

21 Recall Recall ダイアログ・ボックスを開きます。 File > Recall...

22 Save 前の Save 操作と同じ選択内容を使用して作業ファ
イルを保存します。

File > Save

23 Touch Screen
On/Off

タッチ・スクリーンのオン／オフを切り替えます。

24 Help オンライン・ヘルプを表示します。 Help > User
Manual

25 Print Print ダイアログ・ボックスを開きます。RSA6100A ア
プリケーション・ウィンドウの画面取り込みを出力しま
す。

File > Print

26 Preset 機器をデフォルト値またはプリセット値に戻します。
Preset を操作すると、スペクトラム・アナライザ表示
ウィンドウのみが開いた状態になります。

Setup > Preset
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フロント・パネル・コネクタ

番号 アイテム 説明

1 Trig Out トリガ出力コネクタ。50 Ω、BNC、 ハイ > 2.0 V、ロー < 0.4 V、（出力電流
1 mA）

2 Trig In 外部トリガ入力コネクタ、–2.5 V ～ +2.5 V、（トリガ・レベルはユーザ調整
可）

3 USB 1.1 USB 1.1 マウス・コネクタ

4 USB 2.0 USB 2.0 コネクタ

5 RF Input RF 入力コネクタ 50 Ω
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リア・パネル

番号 コネクタ、説明

1 AC 入力、 主電源コネクタ

2 GPIB

3 IF 出力（オプション 05 型）

4, 5 リアルタイム IQ 出力（オプション 05 型）

6 Ref In、基準周波数の入力

7 Ref Out、基準周波数の出力

8 ヘッドフォン、オーディオ出力コネクタ。

9 外部トリガ 2 入力

10 周辺機器接続用 COM 2、シリアル・ポート

11 VGA、外部モニタ出力（解像度は VGA に制限されません）

12 PS2 キーボード入力

13 マウスやその他 USB2 デバイス用 USB2 ポート

14 TekProbe®、予約

15 +28 VDC 出力、（切り替え可能）

16 LAN、イーサネット・ネットワーク・コネクタ
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インタフェースと表示項目

通常使用するボタンやコントロールは、ツール・バー内にあります。ほとんどのボタンで、コントロール・パネ
ルを開き、機器のセットアップを変更することができます。コントロール・パネルの内容は、選択した表示によ
り異なります。フロント・パネルのボタンまたはキーボードからもコントロール・パネルにアクセスできます。

番号 アイテム 説明

1 Displays Select Displays ダイアログ・ボックスを開くと、測定表示を選択できま
す。

2 Markers ウィンドウの下部の Marker ツール・バーを開いたり、閉じたりします。

3 Settings 選択した表示の Settings コントロール・パネルを開きます。各表示か
ら、個別のコントロール・パネルにアクセスできます。

4 Trigger Trigger コントロール・パネルを開くと、トリガ設定を定義できます。

5 Acquire Acquire コントロール・パネルを開くと、アクイジション設定を定義でき
ます。

6 Analysis Analysis コントロール・パネルを開くと、周波数、解析時間、ユニット
など解析の設定を定義できます。
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番号 アイテム 説明

7 Center Frequency 中心周波数を表示します。値を変更する場合は、テキストをクリック
し、フロント・パネルのノブで周波数を調整します。フロント・パネルの
キーパッドまたはフロント・パネルの上下ボタンを使用しても、周波数
を入力することができます。

8 Reference Level 基準レベルを表示します。値を変更する場合は、テキストをクリックし
て、キーパッドから数字を入力するか、フロント・パネルの上下ボタン
を使用します。

9 Amplitude Amplitude コントロール・パネルを開いて、リファレンス・レベルを定義
したり、内部減衰を設定したり、（オプションの）プリアンプの有効／
無効を切り替えたりできます。

10 Replay 新しい設定を使用して、既存のアクイジション・データ・レコードに新
しい測定周期を実行します。

11 Run データのアクイジションを開始または停止します。機器がデータを取
り込んでいるときは、ボタンのラベルの文字が緑で表示されます。停
止すると、ラベルの文字は黒で表示されます。

Run メニューで、実行条件を指定できます。たとえば、Run メニュー
の Single Sequence を選択した場合、Run ボタンをクリックすると、機
器は 1 つの測定周期を実行して停止します。　Continuous を選択す
ると、アクイジションを停止するまで機器は連続して稼働します。

12 チェック・マーク・イ
ンジケータ

画面の左上隅のチェック・マーク・インジケータ（ ）は、その画面用
にアクイジション・ハードウェアが最適化されていることを示します。
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表示固有のコントロール

ほとんどの表示では、よく使われるコントロールがグラフの周囲に配置されています。これらのコントロール
を使用すると、共通の設定にすばやくアクセスできます。なお、Settings コントロール・パネルでは、表示に
関するすべてのコントロールにアクセスすることができます。次の図と表に、ほとんどの表示で使用される共
通のアイコンを一部示します。

表 1: 共通のアイコン

番号
コントロール・ア
イコン 説明

1 ドロップダウン・リスト。このアイコンをクリックして、ドロップダウン・リストか
ら値を選択します。

2 ノブ。このコントロールを選択する場合は、アイコンまたはテキスト・リード
アウトをクリックします。その後、フロント・パネルのコントロール・ノブまた
は矢印キーを使用して値を変更したり、キーパッドから値を入力すること
ができます。

3 6.337 μs イタリック体の数字。自動的に選択されたコントロールの値であることを示
します。機器で使用する複数のコントロール（RBW および Analysis Length
など）では、Auto モードを選択できます。Auto モードでは、機器のソフト
ウェアが自動的に値を設定します。値を変更してコントロールを Manual
モードに切り替えることができます。Auto モードに戻るには、値をクリアし
てから、Enter キーを押します。
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基本概念

リアルタイム・スペクトラム・アナライザ

当社のリアルタイム・スペクトラム・アナライザ（RSA6100A シリーズ・スペクトラム・アナライザなど）では、当社
独自の周波数マスク・トリガをオプションで利用することができます。 この周波数マスク・トリガでは、スペクト
ラムの異常発生をとらえて信号を取り込めるように、スペクトラム・マスクを設定することができます。 このた
め、入力信号を 100% チェックしてから取り込み、狙いを定めた間欠的な RF イベントを高確度でとらえること
ができます。

DPX™ 技術により、RF 信号をライブ表示として観測でき、極端に短いトランゼント信号や、マルチレベル信
号、時間と共に変化するイベントを読み取ることができます。オプション 200 型には、DPX 表示の信号密度
値で測定およびトリガできる機能が備わっています。

RSA6100A シリーズ・スペクトラム・アナライザは、取り込んだ信号をさまざまな相関を取りながら表示すること
ができます。この機能は、デバイスのトラブルシューティングと信号の特性評価に役立ちます。すべての測
定は、同一の基本的な時間領域サンプル・データ・セットに基づいて実行されます。

測定表示

RSA6100A シリーズでは、汎用表示とアプリケーション固有の表示を任意に幾通りにも組み合わせることが
できます。

この例では、DPX スペクトラムのみが
ウィンドウに表示されています。
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この例では、スペクトラムと DPX スペ
クトラムの 2 種類が組み合わされて表
示されています。

複数の表示が開かれている場合、アク
イジション・ハードウェアを制御してい
る表示には、目印としてチェック･マー
クが付いています。別の表示のタイト
ル・バーをクリックすると、表示の優先
権が変わります。

この例は、4 つの表示を同じウィンドウ
に表示しています。

アクイジション・データ・ソースは、ライブ・アクイジションまたは保存したアクイジション・データ・ファイルのい
ずれかです。同じデータを複数の画面に並べて表示し、それぞれ異なる方法で観察することができます。た
とえば、電力と周波数（スペクトラム）の関係を表す画面とスペクトログラム・ダイアグラムを同時に表示できま
す。同じデータ・ソースを異なる画面の間で共有しているため、それぞれの画面には相関性があります。こ
のため、ある画面のポイントやポイントのセットは、同じアプリケーション・ウィンドウ内の他の画面内のポイン
トやポイントのセットと関連しています。
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表示の切り替え
RSA6100A シリーズでは、複数の表示方式がサポートされ、操作方法が簡素化されています。さらに、必要
に応じてより高度な機能を使用することもできます。次のような表示カテゴリがあります。

General Signal Vewing 表示：周波数または時間に対してプロットされる振幅、位相、周波数などの基本
信号パラメータのグラフを表示します。このカテゴリに該当するのが、スペクトラム、DPX、スペクトログラ
ム、時間オーバビュ、および位相対時間です。

Analog Modulation 表示：アナログ変調、周波数変調、および位相変調に対するグラフと測定値を表示し
ます。

General Purpose Digital Modulation 表示： オプション 21 型の汎用変調解析で使用できます。これらの
表示では、信号の復調と信号の解析の結果を複数のドメインで表示します。このカテゴリに該当するの
が、コンスタレーション、EVM 対時間、アイ、シンボル・テーブル、およびトレリス・ダイアグラムです。

RF Measurements 表示：RF 信号の自動測定の結果を表示します。このカテゴリに該当するのが、ACPR、
MCPR、および CCDF です。

Pulsed RF 表示： オプション 20 型の拡張測定解析機能で使用できます。パルス RF 信号の拡張解析の
結果を表示します。このカテゴリに該当するのが、パルス統計、パルス・テーブル、およびパルス・トレー
スです。
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表示の選択
スペクトラム・アナライザの表示は、簡単に選択できます。

1. Displays をクリックして、Select
Displays ダイアログ・ボックス
を開きます。

表示は 2 通りの方法で選択できます。表示を任意に組み合わせて選択する方法と、アプリケーション・プリ
セットを使用する方法です。

表示を任意に組み合わせて選択する方法: 必要に応じて表示を 1 つずつ選択します。

1. Select Displays ダイアログ・
ボックスで、目的のアプリケー
ション・フォルダをクリックしま
す。

各フォルダで使用できる表示
は、Available Displays ペイン
に表示されます。

2. 表示アイコンの 1 つをクリック
します。

3. Add をクリックして（またはアイ
コンをダブルクリックし）、選択
した表示を Selected displays
リストに追加します。追加する
表示が他にもあるときは、この
手順を繰り返します。

4. OK をクリックして、ダイアログ・
ボックスを閉じます。選択した
表示が開きます。
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アプリケーション・プリセットを使用する方法: アプリケーションのプリセットから表示を選択します。

1. Select Displays ダイアログ・ボックス
で、Application Presets... をクリック
します。

2. いずれかのプリセットを選択します。

3. OK をクリックして、ダイアログ・ボッ
クスを閉じます。プリセットの表示が
開きます。 (表 2 参照)。

表 2: アプリケーション・プリセット

プリセット 表示

Modulation Analysis（オプション 21 型のみ） Constellation、DPX Spectrum、Signal Quality、Symbol
Table

Pulse Analysis（オプション 20 型のみ） DPX Spectrum 、 Pulse Table 、 Pulse Trace 、 Time
Overview

Spectrum Analysis（スペクトラム解析 – 0.1 ～ 20
GHz、0.1 ～ 14 GHz、または 0.1 ～ 6.2 GHz）

Spectrum（スペクトラム – 中心周波数：10.5 GHz、7.05
GHz、または 3.15 GHｚ）

Spur Search Multi Zone（スプリアス検索マルチ・
ゾーン）：9 KHz ～ 1 GHz

Spurious（スプリアス）

Time-Frequency Analysis Frequency vs Time 、 Spectrogram 、 Spectrum 、 Time
Overview
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ヒント

フロント・パネルの Displays ボタンを押すと、Select Displays ダイアログ・ボックスが開きます。

表示を追加するには、アイコンをダブルクリックします。

表示を削除するには、次のいずれかの操作を行います。

Selected Displays リストの表示アイコンを選択してから、Remove をクリックします。

Selected Displays リストの表示アイコンをダブルクリックします。

選択されている表示の右上隅にある Close ボタンをクリックします。

複数のアプリケーション・フォルダの表示を組み合わせることもできます。

共通情報メッセージ

次の表に、通常の操作で表示される共通情報メッセージの一部を示します。

表 3: 共通情報メッセージ

メッセージ 説明と推奨される対応

Acq BW too small for current
setup

この表示は、アクイジション帯域幅を現在のデータ・レコードに設定さ
れているアクイジション帯域幅よりも大きくする必要があります。次のい
ずれかの理由が原因と考えられます。

意図しなかった表示が選択されています。選択した表示では、測
定用途に適した確度やダイナミック・レンジを得るために要求したア
クイジション帯域幅が、結果的に不十分なものでした。

メッセージが表示されている表示を選択します。機器がまだデー
タを取り込んでいない場合は、Run をクリックします。

アクイジションが実行中ではないため、測定には直前のアクイジショ
ンより大きい帯域幅が要求されています。

Run をクリックして、より大きい帯域幅を持つ新しいアクイジショ
ンを実行します。

データは、呼び出されたファイルのデータです。

保存したデータのアクイジション帯域幅を大きくすることはでき
ません。小さい帯域幅ですむように測定の設定を調整する必要
があります。

Need swept acq or larger Acq BW 表示に掃引アクイジションが必要な場合でも、その他の表示は掃引
データを処理できません。これは、掃引データが選択した表示に合わ
せてカスタマイズされるためです。

目的の表示を選択すると、選択した表示の要件に合うようにアクイ
ジション設定が自動的に変更されます。

RBW increased to 100 kHz 現在の Spectrum Length または Analysis Length は、狭い RBW フィル
タを使用できるほど長くありません。

Length コントロールが Manual に設定されている場合は、その値を
大きくしたり、Auto に設定したりすると、Analysis Length を必要な
値まで大きくできます。
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測定設定の変更

表示に使用されている設定で、信号の取り込みまたは処理方法を制御します。変更が可能な設定は、選択
した表示によって異なります。

設定にアクセスするには（ここでは、スペクトラム表示の場合）、次の手順に従います。

1. Settings をクリックして、Settings コ
ントロール・パネルを開きます。

2. 使用する信号またはテストに必要
なコントロールを調整します。たとえ
ば、周波数とスパンを設定するには
Freq & Span タブを使用します。コ
ントロール・パネルのほとんどに、他
の関連するコントロールに簡単にア
クセスできるタブがあります。

3. Prefs タブには、表示画面の外観を
変更することのできる次のコントロー
ルがあります。表示によっては、こ
れらのコントロールのどれかが欠け
ているものもあれば、ここに挙げた
以外のコントロールが用意されてい
るものもあります。

波形目盛のオン／オフを切り替
えるには、Show graticule チェッ
ク・ボックスを選択します。

マーカのリードアウトのオン／
オフを切り替えるには、Show
Marker readout in graph チェッ
ク・ボックスを選択します。

トレースの凡例のオン／オフを切
り替えるには、Show trace legend
チェック・ボックスを選択します。

ヒント

スクリーンに複数の表示がある場合、他の表示のいずれかの内部をクリックすると、その表示のコントロー
ル・パネルに変更されます。
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機器のプリセット

設定をデフォルト値に復元するように機器をプリセットすることができます。

1. 機器をデフォルト設定にして起動
するには、フロント・パネルの Preset
ボタンを押すか、Setup メニューから
Preset を選択します。

ヒント

Preset を使用しても、Config In/Out コントロール・パネル、または GPIB アドレス、Save/Export 設定また
は Auto Alignment 設定などの Tools メニューから指定された設定は変更されません。
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信号の接続
スペクトラム・アナライザは、フロント・パネルに 1 つの RF 信号入力があります。入力に信号を接続する前
に、入力信号の要件を順守していることを確認してください。

注意： 機器または機器のアクセサリに静電気による損傷を与えないようにするには、ケーブルを機器の入
力に接続する前に、必ずケーブルの中央および外側の導体にたまっている静電気を接地によって放電して
ください。一端が未接続のケーブルを機器に接続したままにして、ESD (静電放電)アンテナが形成されな
いようにしてください。

必要な信号レベル

次の表に、リアルタイム・スペクトラム・アナライザの測定に使用できる入力信号レベルを表示します。信号
振幅と周波数（正規化ポイント）の確度は保証されています。許容入力値の範囲全体の信号を測定できま
すが、測定の確度は、測定対象信号の周波数や振幅に影響されます（詳細は、RSA6100A シリーズのデー
タ・シートを参照してください）。

RF 信号の入力範囲（CW またはピーク・エンベロープ・パワー）

変調測定要件 スペクトラム表示の要件

-50 dBm ～ +30 dBm DANL ～ +30 dBm

入力信号要件

特性 説明

入力インピーダンス 50 Ω

入力周波数レンジ

RSA6106A

RSA6114A

RSA6120A

9 KHz ～ 6.2 GHz

9 KHz ～ 14 GHz

9 KHz ～ 20 GHz

測定可能な最大連続入力電圧 1 W（+30 dBm）

最大電圧定格 ±40 V DC、AC カップリング

注意： 機器の損傷を防ぐため、1 ワット（+30 dBm）を超える CW 信号を接続しないでください。最大電圧
定格は±40 V DCです。最大パルス仕様は、75 W ピーク、10 μs パルス幅、0.001 デューティ・サイクル、
≥30 dB の減衰。
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RF 信号を接続するには、次の手順に従います。

1. 信号をフロント・パネルの RF INPUT
コネクタに接続します。

ヒント

ソース信号が 1 ワット（+30 dBm）より大きい場合、ソース信号をアッテネータに接続します。アッテネータ
の出力を RF Input コネクタに接続します。

アクイジションの開始および停止

1. Run ボタンをクリックして、アク
イジションを開始します。

データを取り込んでいるときは、
ボタンのラベルの文字が緑で
表示されます。

2. Run ボタンを再度クリックして、
アクイジションを停止します。解
析の処理中の場合、シーケン
スが終了してから停止します。
機器が処理を停止すると、ボタ
ンのラベルの文字が緑から黒
に変わります。

ヒント

フロント・パネルの Run ボタンを押して、アクイジションを開始または停止します。

Run コントロール

Run メニューを使用すると、アクイジションと測定シーケンスを管理するコマンドにアクセスできます。Run メ
ニュー項目に関する情報については、オンライン・ヘルプを参照してください。デフォルトは Continuous が
選択されています。Continuous を選択すると、アクイジションを停止するまで、機器はデータを連続して取り
込みます。Single Sequence を選択すると、Run をクリックしたり、フロント・パネルの Run ボタンを押したりする
たびに、アクイジションを1回実行します。
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マーカ
マーカは、時間、周波数、電力などを測定するときに使用します。マーカは絶対値を測定するため、マーカ
間の差異の測定も行えます。

マーカを使用した周波数と電力の測定

次の手順は、周波数と電力を測定する場合に、Spectrum 表示でマーカを使用する方法を説明します。この
例は、すべてのマーカがオフで、信号がスクリーンに表示されていることを前提にしています。

1. Markers をクリックして、Anal-
ysis ウ ィ ン ド ウの下部の
Marker ツール・バーを開き
ます。

2. Marker ツール・バーのドロッ
プダウン・リストから、Add
Marker を選択します。

最初のマーカは、マーカの
基準（MR）が指定されていま
す。

3. Marker ツール・バーの矢印
ボタンを使用して、スクリーン
のマーカを移動します。タッ
チ・スクリーンまたはマウスを
使用して、マーカを目的の位
置にドラッグすることもできま
す。

4. 周波数と電力レベルは、そ
の表示のマーカのリードアウ
トから読み取ります。

32 RSA6100A シリーズ・クイック・スタート・ユーザ・マニュアル



操作

マーカの表示

長方形のマーカは、リードアウトに絶対値を示します。選択したマーカのリードアウトは、表示の左上隅と
Marker ツール・バーに表示されます。

ダイアモンド形のマーカは、デルタ値（基準マーカを比較とした）を示します。選択したマーカのデルタ・
リードアウトは、表示の右上隅と Marker ツール・バーに表示されます。

タッチ・スクリーンまたはマウスのいずれかで、トレースに沿ってマーカをドラッグすると、マーカは大きい
ポイントを探します。マーカは、マウスの位置から 20 トレース・ポイント以内に存在します。トレース・ポイ
ントの電流範囲内にピークがない場合、マーカは最大ポイントを見つけます。

DPX スペクトラム表示でビットマップ・トレースにマーカを付けると、マーカのリードアウトに、ピクセルの
ヒット・カウント（最大 65,536）、周波数、および電力が表示されます（下図を参照）。マーカはグラフ内の
任意の位置に配置できます。

オプション 200 型が取り付けられている場合、DPX ビットマップ表示に付けられたマーカには、ヒット・カ
ウントではなく、選択したピクセルおける信号密度（パーセント単位）が表示されます。

ヒント

マーカがオフの場合、Marker ツール・バーまたはフロント・パネルにある Peak をクリックして、マーカの
基準（MR）を追加し、この基準を選択した表示のトレースの最大ピークレベルに指定します。

Marker ツール・バーの Table をクリックして、マーカ情報を示す表形式の表示を開きます。
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Marker ツール・バー

Marker ツール・バーには、マーカと連携して機能するコントロールがあります。(表 4 参照)。これらのコント
ロールの一部は、フロント・パネルのコントロールと同様に動作します。

表 4: Marker ツール・バー

アイコン 説明

Define Markers コントロール・パネルを開きます。このコントロールパネルは、マーカの
追加および削除とマーカ・パラメータの設定に使用します。

機器の測定周波数を選択したマーカの周波数に設定します。このボタンは、選択した
表示の水平軸に周波数を設定する場合にのみ表示されます。

マーカを、トレースの最大ピーク・レベルに移動します。最大ピークは、垂直軸の正と
負の値のいずれの場合も（周波数エラーまたは位相エラーなど）、表示内の最大値ま
たは最小値のいずれかになる可能性があります。

選択したマーカを、現在位置の左側の次のピークに移動します。

選択したマーカを、現在位置の右側の次のピークに移動します。

選択したマーカを次に小さいピーク値に移動します。ピーク値は、ピーク振幅の絶対
値を表します。このボタンを繰り返し使用すると、次のピーク位置、その次のピーク位
置へと、マーカが順次移動していきます。DPX ビットマップ・トレースの場合、このボタ
ンを使用すると、同じ周波数で次に小さい振幅密度のピークにマーカが移動します。

選択したマーカを次に大きいピーク値に移動します。ピーク値は、ピーク振幅の絶対
値を表します。このボタンを繰り返し使用すると、次のピーク位置、その次のピーク位
置へと、マーカが順次移動していきます。DPX ビットマップ・トレースの場合、このボタ
ンを使用すると、同じ周波数で次に大きい振幅密度のピークにマーカが移動します。

表示内のマーカ・テーブルを開いたり、閉じたりします。

マーカの追加

最大 5 つのマーカを設定できます。最初のマーカ（MR）は、基準マーカです。他のマーカ（M1、M2、M3、
および M4）は、絶対値を表示したり、マーカおよび参照マーカ間の差分値と絶対値の両方を表示したりで
きます。

別のマーカを追加するには、ツール・バーのドロップダウン・リストから、Add Marker を選択します。
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マーカの定義

Define Markers コントロール・パネルで、マーカの設定を定義します。

1. Define をクリックして、Define Mark-
ers コントロール・パネルを開きます。

コントロール・パネルは、次の目的で使
用します。

マーカを追加または削除します。

マーカをオフにします。

マーカを特定のトレースに割り当て
ます。

マーカのリードアウトを絶対値また
はデルタ値に設定します。

しきい値と偏位値を定義します。

ヒント

Marker ツール・バーの Define の横のドロップダウン・リストから、マーカの追加または削除を実行できま
す。
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タッチスクリーン･アクション
画面上にタッチスクリーン･アクション・メニューを表示して、マーカ設定や波形の表示方法を変更することが
できます。このメニューを表示するには、ディスプレイに指を触れ、1 秒押さえてから放します。また、マウス
の右ボタンをクリックすることでも、表示することができます。

タッチスクリーン･アクション・メニューの
中には、マーカが定義されているとき
にしか選択できない項目もあるので注
意してください。

タッチスクリーン･アクション・メニュー
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表 5: タッチスクリーン･アクション・メニュー

アイコン メニュー項目 説明

Select マーカを選択し、その位置を調整します。

Span Zoom 選択されたポイント周辺のグラフ領域をズームします。グラフ画面の目
的のポイントに触れてドラッグし、その周辺のスパンを増加または減少
させます。Span Zoom でスパン・コントロールを調整すると、アクイジショ
ン帯域幅に影響する場合があります。

CF Pan 水平移動によって、中心周波数を調整します。

Zoom グラフの水平軸および垂直軸スケールを調整します。最初に十分な
動きがあったときのその方向が、最初の調整のスケールになります。
最初の動きと交差する方向に30 ピクセル以上動かすと、今度はその
方向の調節ができるようになります。

左または下にドラッグすると、ズーム・アウトされ、波形が縮小されて表
示されます（スケール値が増加します）。右または上にドラッグすると、
ズーム・インされ、波形が拡大されて表示されます（スケール値が減少
します）。

Pan 波形の水平および垂直位置を調整します。最初に十分な動きがあっ
たときのその方向が、最初の方向の移動になります。最初の動きと交
差する方向に30 ピクセル以上動かすと、今度はその方向の移動がで
きるようになります。

— Reset Scale 水平軸および垂直軸スケールおよび位置の設定をデフォルト値に戻
します。

— Marker to peak 選択されたマーカを最高のピークに移動します。オンになっているマー
カがない場合、このコントロールにより自動的にマーカが追加されま
す。

— Next Peak 選択されたマーカを次のピークに移動します。選択肢は、次の左、次
の右、次の低地点（絶対）、および次の高地点（絶対）です。

— Add marker グラフの水平方向の中央に位置する新しいマーカを定義します。

— Delete marker 最後に追加したマーカを削除します。

— All markers off すべてのマーカを削除します。

Trigger On This DPX 密度測定ボックスをクリック位置に配置して、現在の信号密度を
測定し、測定結果に基づいて DPX 密度トリガ機能をセットアップして、
アクイジションを開始します。
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印刷
スクリーンやスクリーンの内容（スクリーン・ショット）のコピーをプリンタまたはファイルに出力できます。

1. フロント・パネルの Print ボタンを押
すか、File メニューから Print を選
択します。

2. Print ダイアログ・ボックスで詳細情
報を入力し、OK をクリックします。

Print ダイアログ・ボックスは、Mi-
crosoft Windows 標準の Print ダイ
アログ・ボックスです。プリンタのコ
ントロールは、ご使用のプリンタに
よって異なります。

インク・セーバ・モード

白地にスクリーン・イメージを印刷できます。

1. Tools メニューから Options を選択
します。
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2. コントロール・パネルの Colors タブ
を選択します。

3. Color Scheme を Blizzard に設定し
ます。

グラフの背景が黒地から白地に変
わります。
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データの保存
将来使用するために、さまざまなタイプのデータを保存することができます。

1. File メニューから Save As. . . を選
択して、Save As ダイアログ・ボック
スを開きます。

2. セットアップを保存するフォルダに
移動するか、デフォルトの位置を使
用します。

3. ファイル名を入力します。

4. 保存するファイルの種類を選択しま
す。 (表 6 参照)。

5. Save をクリックします。

表 6: 保存用のファイルの種類

ファイルの種類 説明

Setup files Tools メニュー（Alignments と Options）または Config In/Out コントロール・パ
ネルで指定される設定以外の、すべての設定表示に関するセットアップ情報
をすべて保存します。

Results Export files 選択した表示のトレース・データと数値データを保存します。トレース・データ
と数値データは、CSV 形式のテキスト・ファイルとして保存されます。

Picture (PNG/JPG/BMP) スクリーンのグラフィック表示を、指定したフォーマットで保存します。このオプ
ションは、レポートおよびその他のアプリケーションがグラフィックを含む場合
に便利です。マーカのリードアウトおよびその他の情報が含まれています。

Selected Trace トレースを保存したときの表示に後で呼び戻せるように保存します。

Data (acquisition data and
acquisition data export)

データを保存し、RSA6100A シリーズ・リアルタイム・スペクトラム・アナライザ
で再度解析したり、CSV（カンマ区切り値）データとして外部ソフトウェアで使
用したりします。
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ヒント

File > Save を選択するか、Save ボタンを押してファイルに情報を保存する際は、前回保存したときと同
じ名前、パス、およびデータ型を使用します。同じファイルが既に存在している場合、Tools > Options >
Auto Filename コントロール・パネル・タブで前回と同じオプションを選択していると、名前のサフィックス
の数字が増加します。

File > Save As を選択すると、Windows 標準の Save ダイアログ・ボックスが開き、ここでファイル名を編集
したり、保存するデータ型を選択したり、ファイルを格納するフォルダを選択できます。

データの呼び出し
RSA6100A シリーズ・リアルタイム・スペクトラム・アナライザに保存されているアクイジション・データやセット
アップ・ファイルを呼び出すことができます。

1. フロント・パネルの Recall ボタンを
押すか、File メニューから Recall を
選択します。

2. Open ダイアログ・ボックスで、ファイ
ルの位置を参照します。

3. ファイルを参照しない場合は、Files
of Type に表示されるファイルの種
類を選択します。

4. ロードするファイル名をダブルクリッ
クします。

ヒント

電流グラフの X 軸レンジ内に一致しない X 軸レンジを持つトレースを呼び出す場合、トレースは表示され
ません。小さい矢印は、呼び出されたトレースの方向のスクリーンの外を指します。Frequency and Span（ま
たは Span and Offset）コントロールを使用して、スペクトラム表示のスクリーンにトレースを合わせます。他の
表示では、Horizontal Scale and Offset（スペクトラム表示でも使用可能）を使用します。これらのコントロール
は、Settings > Scale タブにあります。
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高度な手法
このセクションでは、高度な操作法について説明します。実用例については、『RSA6100A シリーズ・リアル
タイム・スペクトラム・アナライザ使用例マニュアル』を参照してください。

トリガのセットアップ

RSA6100A シリーズ・リアルタイム・スペクトラム・アナライザは、電力レベル・トリガ、ライン・トリガ、外部トリガ
のほか、リアルタイム周波数領域トリガ（オプション 02 型）を備えています。トリガ・イベントは信号をシームレ
スに取込むための時間の基準ポイントとして使用されます。この結果、スペクトラム・アナライザは、プリトリガ
とポストトリガのいずれの情報もストアすることができます。

スペクトラム・アナライザには、次の 2 種類のトリガ・モードがあります。

Free Run モード: Free Run モードの場合、機器は、トリガ条件を一切考慮せずにアクイジションを初期化
します。また、信号を高速かつ簡単に確認することができます。データ・レコードを収集する時間を特に指定
する必要がなければ、Free Run は一般に、スペクトラム表示に適しています。

Triggered モード: Triggered モードでは、機器はトリガ・イベントを認識した場合にアクイジションを初期化
します。トリガ・イベントを定義する条件は、選択したトリガ・ソースによって異なります。トリガ・イベントをモニ
タする信号を選択する場合に使用可能なソースが複数あります。

Triggered モードを選択すると、ソースを選択する必要があります。次のトリガ・ソースから選択します。

RF Input

Trig In

Trig 2 In

Gated

Line

トリガ・ソースを選択すると、トリガ・イベントを指定する追加パラメータを設定することができます。RF In put
をトリガ・ソースとして指定する場合、次の 2 種類のトリガから選択できます。

DPX 密度トリガ: このトリガを使用すると、DPX 表示で観測できるすべての信号（振幅の大きい信号や反
復レートの高い信号に隠れがちの信号も含む）を取り込むことができます。Trigger On This™ 機能を使用す
れば、グラフ内の目的領域周辺にボックスを描画して、密度スレッショルドを設定し、測定された密度がスレッ
ショルドを超えたときに機器をトリガすることができます。

時間クオリファイド・トリガ: このトリガを使用すると、信号の遷移が発生したタイミングに基づいて機器を
トリガすることができます。時間クオリフィケーションは、基本的なトリガの形式に適用できます。たとえば、トリ
ガとして電力を選択し、立上りエッジでトリガするように設定した場合、時間クオリフィケーションを使用する
と、信号がトリガ･スレッショルドを超えた後高い状態を持続した時間に基づいて、立上りエッジ・イベントを選
別できます。このパルスの持続時間が指定時間より長いか短い場合のみトリガすることもできます。これを実
現するには、パルス幅が 2 つの指定値の範囲内にある場合のみ、または 2 つの値の範囲外にある場合の
みトリガを許可するよう Time Qualified を設定します。

周波数マスク・トリガ・イベント、DPX 密度トリガ・イベント、および Runt（ラント）トリガ・イベントを時間でクオリ
ファイすることもできます。それには、トリガ形式ごとに、基本的なトリガ基準を満たすすべてのイベントを検出
し、それらのイベントを時間クオリフィケーション・パラメータ設定と照合して目的のイベントだけを抽出します。

Frequency Mask トリガ: Frequency Mask トリガを選択すると、周波数領域の信号がマスクを違反した場
合に、機器をトリガできます。リアルタイム周波数帯域内に、トリガ・イベントが生成されるように条件を定義
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するマスクを書き込めます。このトリガでは、強い信号が存在する場合も弱い信号でのトリガが可能です。ま
た、間欠的に発生する信号の取り込みにも便利です。

Power トリガ: Power トリガを選択すると、時間領域信号の特性に基づいて機器をトリガします。入力デー
タを dBm でのユーザ選択レベルと比較します。時間領域帯域幅を選択し、立上りエッジまたは立下りエッ
ジでトリガできます。

トリガ・イベントの定義に加え、トリガ・コントロール・パネルの適切なタブを選択し、次のパラメータを定義す
ることもできます。

取り込んだデータ・レコード内のトリガ発生場所を指定する Position パラメータ、および、トリガを一定時
間遅らせるかどうかを指定する Delay パラメータ

1 つのイベントで掃引全体のトリガを可能にするかどうか、または掃引アクイジション・モードで掃引のセ
グメントごとに新しいトリガ・イベントを必要とするかどうかを指定するパラメータ
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トリガ・パラメータへのアクセス

1. Trig をクリックして、Trigger コント
ロール・パネルを開きます。

2. 以下の手順で示すように、Trigger
コントロール・パネルのタブを 1 つ
クリックして、トリガ・パラメータを定
義します。

3. Event タブは、トリガ・イベントを定
義するパラメータを設定するときに
使用します。パラメータは、トリガの
ソースと種類の選択によって異なり
ます。

4. Time Qualified タブでは、持続時間
を基準にトリガ・イベントをクオリファ
イするパラメータを設定します。

5. Advanced タブでは、掃引アクイジ
ション・モードでセグメントごとにトリ
ガするかどうか指定します。また、ト
リガ・イベントの位置を制御するパラ
メータを設定します。

ヒント

他にも次の方法で Trigger コントロール・パネルにアクセスできます。

フロント・パネルの Trigger ボタンを押します。

Setup メニューから Trigger . . . を選択します。
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DPX 密度トリガのセットアップ

DPX 密度トリガを使用すると、振幅の大きいまたは周波数の高い別の信号によって一部が隠されている過
渡状態を取り込むことができます。過渡的な状態を DPX ビットマップで観測できれば、それに基づいてトリガ
できます。DPX 密度領域の測定は、表示内で目的領域を選択し、その現在の密度を測定するために使用
します。密度スレッショルドを設定して、密度の測定値がスレッショルドを超えたときに機器をトリガできます。

DPX 密度トリガを簡単にセットアップするには、マウスを使用して DPX グラフ内で目的の信号を右クリック
するか、画面を指で 1 秒間押し続けます。これによりメニューが表示されます。Trigger On This を選択しま
す。この操作により次の処理を実行できます。

クリックしたポイントに密度測定ボックスを配置する

測定ボックスをデフォルト・サイズに設定する

ボックス内で平均密度を測定する

トリガ・モードを Triggered に設定する

DPX 密度の高さに基づいたトリガ形式を選択する

トリガ・スレッショルドを現在の測定値を若干下回る密度値に調整する

アクイジション処理を開始する

DPX 密度トリガの設定を特定の信号に合わせて最適化するには、Trigger コントロール・パネルを開きます。
コントロールを使用して、トリガのスレッショルド比較の極性（Higher または Lower）、スレッショルド値、測定
ボックスのサイズと位置を変更してください。ボックスの中心を配置するには Frequency 設定および Amplitude
設定を使用します。また、測定ボックスの幅と高さを調整するには +/- 値を設定します。

強い信号によって一部が隠されているイベントを検出するには、そのイベントとそれを覆い隠している信号
の密度測定値に基づいて、密度のスレッショルドを調節すると効果的です。たとえば、強い信号のみを示す
背景色の密度が 7% で、両方の信号を含む密度測定値が 9% であれば、スレッショルドを 8% に設定します。

目的の信号が連続的な信号であり、この信号が別の周波数にホップしたり低い振幅にドロップしたときにイ
ベントを取り込みたい場合は、密度測定ボックスを移動して信号のピークを囲み、Density コントロールで
Lower を選択して、 Threshold を 100% に設定します。これにより、信号が測定ボックスから外れたときに機
器がトリガされます。
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ヒント: 密度測定値は、ボックス内の各ピクセル列に対する密度の平均値です。測定ボックスが連続波信号
のピークより広い場合、密度の読み値は 100% 未満となります。読み値を 100% にするには、RBW を増やして
ピークを広げるか、ボックスの上下いずれかに色付きピクセルがなくなるまでボックスを狭めます。信号はボッ
クスの左側から入り、右側に抜ける必要があります。また、ボックスの下部エッジをまたぐことはできません。

周波数マスクの作成

周波数マスクを作成するには、Mask Editor を使用します。マスクは、周波数と振幅で定義する一連のポイ
ントですTrigger コントロール・パネルから Mask Editor にアクセスできます。（この手順は Spectrum 表示を
使用します）。

周波数マスクは、手動または Auto Draw 機能を使用して作成できます。次の手順では、手動による方法を
説明しています。Auto Draw 機能を使用した手順については、オンライン・ヘルプの「Mask Editor （周波数
マスク･トリガ）」を参照してください。

1. Trig をクリックして、Trigger コント
ロール・パネルを開きます。

2. コントロール・パネルの Event タブ
を選択します。

3. ソースを RF Input に設定します。

4. Type を Frequency Mask に設定し
ます。

5. Mask Editor をクリックして、Mask
Editor を開きます。

Mask Editor は、グラフに Spectrum
表示のトレースを表示して開きます。

6. ツール・バーの New をクリックしま
す。この操作では、既存のマスクを
削除し、デフォルトの 6 ポイントのマ
スクを作成します。
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7. マスク内の任意のポイントをクリック
して、それを選択します。

グラフ内で選択したポイントの周波
数と振幅が、ハイライト表示されま
す。

8. ポイントを編集するには、次のいず
れかの操作を行います。

マウスでポイントをドラッグ・アン
ド・ドロップします。

周波数と振幅を表に入力します。

上下矢印キーで振幅を調整し、
左右矢印キーで周波数を調整
します。

ヒント

基準に合わせてマスクを自動生成するには、Auto draw をクリックします。

新しいポイントを追加するには、表示スクリーン上で右クリックします。

グラフに新しいポイントを追加する場合は、Add Points をクリックしてから、グラフ上でクリックします。

グラフ内の次のポイントを選択する場合は、Next をクリックします。

選択したマスク・ポイントを削除する場合は、X（削除ボタン）をクリックします。

マスク・ファイルを保存し、Mask Editor で作業を続行する場合は、Save をクリックします。

前に保存されたマスク・ファイルを読み込んで編集する場合は、Open をクリックします。

トリガ条件の定義

マスクをセットアップしたら、マスク違反の有無でトリガするかどうかを選択することができます。

1. 条件を選択します。

以下に選択内容を示します。(表 7
参照)。コントロール・パネル下部の
アイコンは、True または False とみ
なされるものを特定します。

2. Triggered をクリックします。

トリガ条件が一致すると、機器はトリ
ガされます。
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表 7: トリガ違反

違反 説明

T 信号がマスクを違反すると（ラインの上）、機器はトリガされます。

F 信号がマスク内にポイントを持たないと、機器はトリガされます。

T > F 1 つのトランザクションでトリガ・イベントを定義します。信号は、マスクの内部
にある（違反）場合、マスクの外部（無違反）に移動する必要があります。

F > T 1 つのトランザクションでトリガ・イベントを定義します。信号は、マスクの外部
にある場合、マスク内部に移動する必要があります。

T > F > T 2 つのトランザクションでトリガ・イベントを定義します。信号は、マスクの内部
から開始され、マスクの外部へ出てから、マスク内部に入る必要があります。

F > T > F 2 つのトランザクションでトリガ・イベントを定義します。信号は、マスクの外部
から開始され（無違反）、マスク内部に入ってから、マスク外部に出る必要が
あります。

アクイジションの制御

2 つ以上の表示が開いている場合、1 つの表示がアクイジション・システムを制御します。選択した表示のア
クイジション要件によって、アクイジション・ハードウェア・パラメータが設定されます。アクイジション・パラメー
タは、選択した表示用に最適化されますが、他の表示にとって最適ではない可能性があります。この場合、
その他の表示は最適なパフォーマンスを維持できず、結果的に効果を上げられない場合があります（その
ため、呼び出されたデータを解析する際、測定して結果を出そうとしても、測定の設定すべてに適合できな
い場合もあります）。

ハードウェア・アクイジション・パラメータを制御する表示を指定するには、その表示の任意の場所をクリックし
ます。複数の表示がある場合、ハイライトされた表示がハードウェア・アクイジション・パラメータを制御します。

この例では、スペクトラム表示と DPX ス
ペクトラム表示の2 種類の表示がありま
す。DPX スペクトラム表示のハイライト
されたタイトル・バーは、表示が選択さ
れていることを示しています。

画面の左上隅にあるチェック・マーク・
アイコンは、アクイジション・ハードウェ
アがスペクトラム表示用に最適化され
ていることを示しています。

アクイジション・ハードウェアを制御しない表示もあります。このような表示は、取り込まれたデータだけを示し
ます。同じパラメータを共有する表示もあります。この場合、これらの表示のいずれか 1 つがアクイジション・
ハードウェアを制御すると、アクイジション・パラメータは、すべての表示に対して最適化されます。
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競合するアクイジション要件での測定

RSA6100A シリーズ・リアルタイム・スペクトラム・アナライザは、複数の測定の組み合わせを開くことができま
す。目的の表示を選択すると、適切な解析とアクイジションのパラメータが自動的にセットアップされます。

測定がアクイジション・パラメータと競合する場合、現在選択されている表示が優先されます。次の例は、あ
る表示がリアルタイム・データ (振幅対時間測定など) を必要とし、別の表示が掃引データ (広範囲なスパン
が設定されたスペクトラム・グラフなど) を必要とする場合の互換性のない測定設定を示します。

1. フロント・パネルの Preset ボタンを
押し、機器の設定をデフォルト設定
に戻します。

2. 信号の周波数に合わせて機器を調
整した後、スパンを設定します。

3. Displays をクリックして、Select Dis-
plays ダイアログ・ボックスを開きま
す。

4. General Signal Vewing フォルダを選
択します。

5. Amplitude vs Time アイコンを選択
します。

6. Add をクリックして、そのアイコンを
Selected Displays リストに追加しま
す。

注： Spectrum表示が Selected Displays
リストにまだ存在しない場合は、Spec-
trum 表示を追加してください。

7. OK をクリックし、変更を適用してダ
イアログ・ボックスを閉じます。
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8. Run をクリックして、データの取り込
みを開始します。

9. Spectrum 表示のスパンを 200 MHz
まで大きくします。

Spectrum が選択された表示なの
で、アクイジション・パラメータは自
動的に表示の要求に適合するよう
に調整されます。200 MHz スパン
は、機器のリアルタイム帯域幅を超
えています。その結果、機器のモー
ドは掃引に変更されます。

10.ステータス・バーを確認します。リー
ドアウトの "Swept" は、アクイジショ
ンが掃引されていることを示します。

アクイジションが "Real Time" と表
示されている場合、すべての測定
は通常実行されています。アクイジ
ションが掃引モードの場合、実行で
きるのは選択された表示のみです。

11.Amplitude vs Time 表示をクリックし
て、アクティブな表示にします。

選択された表示はリアルタイムでな
ければならないため、アクイジション
はリアルタイムに戻ります。データは
現在、Amplitude vs Time 表示に適
応していますが、Spectrum 表示が
必要な周波数のフルレンジには対
応していません。

その場合、Spectrum 表示は実行で
きません。
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12. Spectrum 表示のスパンを 40 MHz
まで小さくします。これで、アクイジ
ションは再度リアルタイムになりまし
た。

13. ステータス・バーのリードアウトを
チェックして、アクイジションがリア
ルタイムであることを確認してくださ
い。

Spectrum とAmplitude vs Time の両
表示を動作できます。
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信号の検索

RSA6100A シリーズ・リアルタイム・スペクトラム・アナライザを使用すると、パワー・レベルが変化する信号を
検索できます。あるパワー・レベルを超えたときに一致したものとみなしたり、パワー・レベルおよび周波数レ
ンジのリミットを指定するマスクを作成できます。検索するトレースを選択して、一致したものがあった場合に
行う動作を指定できます。

トレースを検索するには、次の手順を実行します。

1. Spectrum 画面を開きます。すでに
開いている場合は、Spectrum 画面
を選択します。

2. Tools > Search を選択します。

3. Enable Search チェック・ボックスを
選択します。

4. Search in ドロップダウン・リスト・ボッ
クスから検索するトレースを選択し
ます。

5. Search in リストで選択したトレース
が目的のトレースか確認し、Show
ボックスがチェックされていることを
確認します。
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6. 検索内容を Search for ドロップダウ
ン・リストから選択して指定します。

指定したレベルより上または下の信
号レベルを検索するには、is greater
than または is less than を選択しま
す。

周波数によって変動する信号レベ
ルを検索するには、is outside mask
または is inside mask を選択しま
す。検索マスクのリミットを指定する
には、Edit limits ボタンをクリックし
ます。

グラフ画面のオレンジ色の影付き
領域は、そこに信号が来たときに一
致とするレベルを示します。

greater than 検索が選択されたときの画面

outside mask 検索が選択されたときの画面
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7. Actions タブをクリックして、一致し
たものがあったときのスペクトラム・ア
ナライザが行う処理を指定します。

スペクトラム・アナライザは、実行
モードにより、一致したものがあっ
たときに最大 5 つまでの処理を行
うことができます。Run モードでは、
スペクトラム・アナライザは、ビープ
音による通知、アクイジションの停
止、アクイジション・データの保存、
トレース・データの保存、および画
面のピクチャの保存を行うことがで
きます。Replay モードでは、ビープ
音による通知、解析の停止を行うこ
とができます。

8. 一致したものがあったときにスペク
トラム・アナライザに処理を実行さ
せるために、目的の処理を選択し
ます。

一致時に実行する処理は、どのよ
うな組合せでもかまいません。すべ
ての処理を選択すると、一致したも
のが見つかったときに、すべての処
理が実行されます（Run モード）。

9. 閉じるボックスをクリックして、Search
コントロール・パネルを消します。

10.RUN ボタンを押して、検索を初期
化します。

入力データに一致したものがある
と、グラフ画面に赤いラインが表示
されます。ツール・バーの Replay ボ
タンをクリックすると、現在のデータ・
レコードの検索が初期化されます。
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補正テーブルの使用

RSA6100A シリーズ・リアルタイム・スペクトラム・アナライザでは、外部機器の利得や損失を考慮して信号表
示および測定結果を補正することができます。単一の利得値を指定したり、周波数に基づいて利得／損失
値を調整する外部損失テーブルを使用できます。

外部利得／損失の補正を指定するには、次の手順を実行します。

1. Ampl ボタンを押して、Amplitude コ
ントロール・パネルを表示します。

2. External Gain/Loss Correction タブ
を選択します。

3. 定数補正率を適用するには、 Ex-
ternal Gain value チェック・ボックス
を選択します。値をテキスト入力ボッ
クスに入力します。

注： 正または負の利得値を入力できま
す。正の値は利得を表し、負の値は損
失を表します。

4. 周波数に依存する利得／損失値を
補正するテーブルを使用するには、
External Loss Tables の下のチェッ
ク・ボックスをクリックします。

3 つの外部損失テーブルをすべて
同時に使用できます。したがって、
アンテナ、プリアンプ、ケーブル用
に別の外部損失テーブルを使用で
きます。

5. 外部損失テーブルの内容を編集す
るには、編集するテーブルの Edit
ボタンをクリックします。
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6. 補正する機器の損失特性に合わせ
て、表の内容を編集します。完了し
たら、OK をクリックします。

注： テーブルには正または負の値を入
力できます。External Gain の値の設定
とは対照的に、正の値は損失を表し、
負の値は利得を表します。

Table Editor の使用方法の詳細は、
Help > User Manual を選択して、Ex-
ternal Loss Tables のインデックスを調
べてください。

7. それぞれの外部損失テーブルのタ
イトルを変更できます。タイトル・ボッ
クスを選択して、新しいタイトルを入
力します。

タイトルはたんなるラベルにすぎま
せん。ロードまたは保存したテーブ
ルのファイル名とは関係ありません。

8. テーブルの修正を、取り込んだすべ
てのデータに適用するか、Spectrum
表示、Spectrogram 表示、Spurious
表示、および Amplitude vs Time 表
示のトレースのみに適用するかを指
定します。
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サンプル・データまたはトレースを
修正するかどうかは、次の点に注意
して決定してください。

データ修正を有効にしてサンプル・
データを取り込んだ場合、そのデー
タ･レコードに加えられた修正を後
で取り除くことはできせん。保存し
て呼び出したアクイジションには修
正が含まれています。修正内容は
アクイジション処理中にデータ値を
調整するために使用されるだけで
あり、生データと別個に保存される
わけではありません。

トレースの修正は測定値の演算処
理の 1 つであるため、いつでも実
行できます。このコントロールが有
効な場合（また、外部損失テーブル
が指定され有効な場合）、Replay を
使用するとトレースの修正内容がト
レースに適用されます。

修正が加えられたアクイジション・
データを呼び出して、トレース修正
を選択し、外部損失テーブルを有効
にした状態で Replay を使用するの
は要注意です。これは、修正データ
に基づく演算に加えてトレース修正
までも適用され、不適切なトレース
が作成されることが多いからです。

9. 変更し終えしたら、閉じるボックス
をクリックして、Amplitude コントロー
ル・パネルを消します。
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オーディオ復調の使用

RSA6100A シリーズ・リアルタイム・スペクトラム・アナライザは、オーディオ信号を復調できます。これにより、
不明な無線信号の特定に役立てることができます。DPX Spectrum 画面の Settings コントロール・パネルか
ら Audio Demod タブにアクセスできます。

オーディオ信号を復調するには、次の手順を実行します。

1. Displays ボタンを押して Select Dis-
plays ダイアログ・ボックスを表示し
ます。

2. General Signal Viewing フォルダを
選択します。

3. DPX Spectrum アイコンをダブルク
リックして、それを Selected Displays
リストに追加します。

4. OK をクリックしてダイアログ・ボック
スを閉じます。DPX Spectrum 画面
が開きます。

5. Settings フロント・パネル・ボタンを
押して DPX Spectrum Settings コン
トロール・パネルを表示します。

6. Audio Demod タブをクリックして、
Audio Demod コントロール・パネル
を表示します。
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7. On ボタンをクリックして、オーディオ
復調を有効にします。

8. 復調タイプを指定するには、AM ま
たは FM ボタンをクリックします。

注： AM および FM ボタンは単に復調
タイプを選択するだけで、周波数帯域
は指定できません。

9. 必要に応じて中心周波数を設定し
ます。

レシーバ周波数（復調する周波数）
をマーカまたは周波数コントロール
（フロント・パネルの Frequency ボタ
ンまたはツール・バーの Freq コン
トロール）で指定します。Tune with
設定を使用して、レシーバ周波数
の指定にマーカまたは周波数コン
トロールのいずれかを使用するかを
指定します。

10.Tune with ドロップダウン・リストから、
マーカまたは周波数コントロールを
選択します。

11.選択したマーカが有効でない場合
（有効な場合は画面に表示されま
す）、ツール・バーの Markers ボタ
ンをクリックして、Markers ツール・
バーを表示します。
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12.Marker ツール・バーの Define ボタ
ンをクリックして、Define Markers コ
ントロール・パネルを表示します。

13.必要に応じて、Add をクリックして
マーカを追加します。

14.Settings ボタンをクリックして、Audio
Demod コントロール・パネルに戻り
ます。

15.Receiver BW 値入力ボックスに値を
入力して、必要なレシーバ帯域幅
を設定します。
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16.レシーバ周波数を設定します。

Tune with 設定でマーカを指定した
場合、マーカを必要な周波数にド
ラッグします。フロント・パネル・ノブ
またはマウス・ホイールを使用して、
マーカの位置を微調整します。Tune
with 設定で Frequency control を
選択した場合、フロント・パネルの
FREQ ボタンを押して、フロント・パ
ネル・ノブを調整するかツール・バー
の Freq 設定を使用して、必要な周
波数を設定します。

レシーバ周波数は、Receiver Freq
として Tune with と Receiver BW 設
定の間に表示されます。

17.復調信号が聞こえるように、Audio
Gain 設定を調整します。サウンド・
レベルは Windows のボリューム・コ
ントロールの設定によっても影響さ
れるので、注意してください。
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検索, 52
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コネクタ
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